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Cos'è
È un ottimo programma libero per creare, manipolare e ottimizzare immagini, soprattutto di tipo  
bitmap ma anche vettoriali. Essendo gratuito, pur ottimo, non è però all'altezza di programmi a  
pagamento come Fireworks o Photoshop.
Per "libero" si intende che non solo lo si può usare senza pagarlo, ma che è accessibile anche il 
codice sorgente da cui è nato, così che chiunque sappia come fare, lo può migliorare o integrare.  
Tant'è che difatti si possono aggiungere, al software base, tutta una serie di estensioni (o plug-in) 
che ne aumentano la potenza, a seconda delle esigenze personali.
La "G" di GIMP deriva dal progetto GNU (nato nel 1983) che riguarda appunto il software libero.
Le altre 3 lettere "IMP" stanno per Image Manipulation Program.

Interfaccia
A differenza di altri programmi,  i cui strumenti e finestre sono tutti racchiusi all'interno di una 
stessa finestra principale di programma, in GIMP avremo varie finestre indipendenti, in particolare 
due, quella principale, con i comandi generali del programma:

e quella degli Strumenti:

Ridimensionabili e spostabili a piacere. Conviene tenere la prima alla massima grandezza perché è 
qui che saranno aperti i vari disegni, anche più d'uno alla volta, in finestre indipendenti.
Poi esistono molte altre  finestre,  abbinate ai vari  strumenti:  doppio clic su uno strumento per 
aprire la finestra corrispondente alle sue opzioni.  Altre finestre sono indipendenti da particolari 
strumenti e sono radunate sotto Finestre → Finestre agganciabili. 

Anche le finestre abbinate alle opzioni sono agganciabili: significa che possono essere trascinate 
nello spazio sotto alla finestra degli strumenti. Le se deve prendere appena sotto al titolo principale  
(fig. 1), poi trascinate (fig. 2) verso la posizione desiderata: o sopra o sotto o accanto ad altre già 
spostate sotto alla finestra degli  Strumenti.  Se sono  accanto,  allora  saranno sovrapposte  come 
schede, il che è molto comodo.

fig. 1 fig. 2
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Preferenze
In  ogni  momento  si  può  personalizzare  il  modo  di  lavorare  con  GIMP accedendo  al  dialogo 
Modifica  → Preferenze,  composto da numerose schede, per gestire, ambiente, interfaccia, temi, 
opzioni, strumenti, griglia, cartelle, colori, ...

I colori
Come è noto, tutti i colori sono formati da una mescolanza di tre colori base, che sono (secondo la 
convenzione più diffusa anche in informatica): rosso (red), verde (green) e blu (blue). La codifica 
che nasce da questo fatto fisico è nota come RGB, dalle iniziali dei 3 colori in inglese. La "dose" 
standard di ciascun colore è un numero che va da  0 a  255. Quindi si ottengono 256*256*256 = 
28*28*28  =  224  =  16,8  milioni  di  colori!  In  questo  modo  bastano  3  soli  byte (=24  bit)  per 
memorizzare un colore qualunque in questa gamma. Colori principali e loro codifica:

colore inglese R G B esadecimale
nero black 0 0 0 000000
rosso red 255 0 0 FF0000
verde green 0 255 0 00FF00
blu blue 0 0 255 0000FF
giallo yellow 255 255 0 FFFF00
magenta magenta 255 0 255 FF00FF
ciano cyan 0 255 255 00FFFF
bianco white 255 255 255 FFFFFF

Ad esempio C45A74 è un tono di rosso tendente al rosa dato da queste dosi di colori base:

colore dose in 
esadecimale

Corrispondente 
dose in decimale (calcolo)

rosso C4 196 = 12 x 16 + 4
verde 5A 90 = 5 x 16 + 10
blu 74 116 = 7 x 16 + 4

La  codifica esadecimale è quella normalmente usata dalle pagine web (codifica HTML) e da 
molti programmi di grafica. Ce ne sono altre:

• Codifica  CMYK:  deriva da  Cyan-Magenta-Yellow-blacK (il  ciano è un tono di azzurro, il 
magenta è un tono di rosa, yellow è giallo e black è nero). Sono i colori dei quattro inchiostri 
usati in tipografia e nelle stampanti a colori.

• La codifica RGB riflette il fenomeno fisico della "addizione" dei colori (ad esempio un fascio 
di luce rossa, sovrapposta ad un fascio di luce verde, viene percepita dall'occhio come giallo),  
la CMYK riflette il fenomeno fisico della "sottrazione" dei colori (ad esempio un inchiostro 
giallo mescolato con un inchiostro ciano diventa un inchiostro verde). 

RGB: addizione CMY: sottrazione
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In codifica CMYK, quel rosso rosato di prima diventa un  (0,138,104,59),  sempre espresso con 
numeri compresi fra 0 e 255. La codifica CMYK è più adatta a produrre immagini da stampare,  
quella RGB per immagini da proiettare. 

• Codifica  HLS:  deriva  da  Hue (tonalità),  Lightness (luminosità),  Saturation (saturazione). 
Esempio:  il  rosso  rosato  di  prima  è  espresso  come  (245,143,121),  al  solito  i  numeri  si  
intendono compresi fra 0 e 255.

• Codifica HSV: deriva dal modello (tonalità, saturazione e valore). La sua nascita deriva dal 
modo  fisico  in  cui  l'occhio  umano  percepisce  i  colori.  Esempio:  il  rosso  rosato  di  prima 
corrisponde ai valori (245,138,196).

GIMP offre vari modi di scegliere il colore così da usare quello più familiare o più comodo per  
l'esigenza del momento. In ogni caso lo traduce sempre nella notazione HTML, che resta la più 
importante e standard,  nel  web.  GIMP è dunque più adatto a produrre immagini  da proiettare.  
Purtroppo infatti, nonostante sia presente la gestione della codifica CMYK per la simulazione dei  
colori in stampa, in realtà non si possono creare o modificare immagini CMYK, ottenendo quindi  
risultati non perfetti in stampa.

Colore di primo piano e di sfondo, scambiabili fra loro facendo clic sulla doppia 
freccia. GIMP chiama "alfa" la trasparenza. 
I colori "indicizzati" sono quelli che hanno una codifica HTML.

Iniziare un nuovo disegno
Creare  lo  spazio  con  File  → Nuovo:  prima  di  confermare  va  decisa  la  misura  e  altri  dettagli 
importanti, in particolare lo "Spazio colore": o RGB o Scala di grigi (quindi non CMYK). Una 
volta creato lo spazio, conviene usare subito File → Salva per assegnare un nome e una cartella. 
L'estensione sarà XCF. Penseremo poi all'ottimizzazione in GIF o JPG.

Disegnare a mano libera
Si usano questi strumenti: 

Alcuni sono pensati non per il normale mouse ma per tavolette grafiche sensibili alla pressione.
Provare le varie opzioni. In particolare: per provare le "Modalità" conviene avere qualcosa di nero 
e di rosso, e provare con un pennello verde, tenendo presente la teoria dei colori descritta prima.

Per ciascuno di questi strumenti, se si tiene premuto SHIFT e/o CTRL accadono cose utili:
• tasto SHIFT: per tratti perfettamente dritti;
• tasto  CTRL:  o  attiva  il  contagocce (per  copiare  il  colore  da  un'altra  zona)  o  forza  (solo 

assieme a SHIFT) un particolare angolo (va a scatti di 15°).

Selezionare
Principali strumenti: 

 e 

Da provare anche in abbinamento a SHIFT o CTRL.
Gli altri strumenti di solito agiscono solo all'interno delle aree selezionate.
I vari strumenti offrono molte opzioni, per esempio la sfumatura. 
Con clic destro → Seleziona → Rettangolo arrotondato su una selezione rettangolare si possono 
arrotondare gli angoli. Altri effetti di selezione interessanti con il  clic destro, in particolare  clic  
destro → Seleziona → Inverti che seleziona l'esterno (o viceversa) della selezione corrente.

Fra le opzioni della selezione notare la modalità, che serve per decidere se una nuova selezione  
sostituisce, aggiungere, toglie o interseca quella precedente:
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Altro modo: selezione per maschera veloce. Utile ad esempio per selezionare un viso. Come si fa:
clic sul  cerchietto tratteggiato in basso a sinistra nella finestra immagine ("Commuta maschera 
veloce") → l'immagine appare velata di rosso → impostare il bianco come colore di primo piano → 
scegliere lo strumento Pennello  → pennellare l'area desiderata (che perderà la velatura rossa)  → 
clic sullo stesso pulsante (ora quadrato).

Altro modo per scontornare una immagine in primo piano: usare  (strumento Selezione primo 
piano). Funziona bene solo su margini molto netti. Si usa in tre passi consecutivi:

1) Si traccia un contorno di selezione grossolano, cercando di restare all'interno della forma  
da selezionare, 
2) ora il puntatore ha la forma del pennello (la cui dimensione è personalizzabile): si disegna 
una linea continua nel primo piano selezionato andando sopra ai colori che verranno tenuti  
dall'estrazione. Il colore usato per tratteggiare la linea non è influente ma è meglio non usare lo  
stesso colore come primo piano. Attenzione a non dipingere punti dello sfondo. (usate CTRL in 
abbinamento  per  sottrarre  anziché  aggiungere  alla  selezione).  L'area  considerata  ha  una 
colorazione diversa. 
3) Premere INVIO per accettare.

Io però trovo più efficace lo strumento  (Selezione fuzzy) abbinato eventualmente a CTRL o 
SHIFT (per  togliere  o  aggiungere  alla  selezione).  In  ogni  caso,  usando  la  tecnica  sulla  quale 
abbiamo fatto più pratica e ci è più congeniale, riusciamo ad esempio ad estrarre un fiore dal suo  
prato,  come  in  questo  esempio,  per  poi  appoggiarlo  sopra  ad  uno  sfondo  del  tutto  diverso, 
sfruttando i livelli, che vedremo più avanti.

Utile anche la  selezione per colore, che si fa con  Seleziona  → Per colore  (=SHIFT+O), che, a 
differenza della selezione fuzzy, seleziona anche aree non contigue.

Infine, qualunque sia la selezione, per  invertire la selezione (cioè selezionare la zona opposta a 
quella già selezionata, rispetto al totale dell'immagine) si usa Seleziona → Inverti (=CTRL+I).

Cancellare, copiare, spostare la selezione
Copia o  spostamento di una parte: selezionare, copiare (CTRL+C) oppure tagliare (CTRL+X), 
annullare  la  selezione (se  no ottengo un fluttuante  poco maneggevole),  incollare  (CTRL+V) e 
spostare a piacimento.
Per cancellare l'area selezionata si usa CANC: il buco assumerà il colore dello sfondo oppure sarà  
trasparente (v. argomento "Livelli").

Disegni geometrici
Con Filtri → Render → Gfig si creano forme geometriche regolari. Si apre un nuovo ambiente, si  
disegna e si conferma. Si ottiene comunque un bitmap che non è più modificabile.
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Riempimenti
Principali strumenti: 

ciascuno con le sue opzioni, tutte da provare. Agiscono sulla selezione, quindi si possono usare per  
creare forme geometriche colorate. Interessante la gestione dell'opacità (o trasparenza).

Tracciati
Sono curve libere composte da punti (detti "punti àncora") e dalle tangenti in quei punti, secondo 
un modello matematico inventato dal francese Bèzier. 
Si  possono  disegnare  a  mano  libera  (fissando  i  punti  e  definendo  le  tangenti)  oppure  si  può 
convertire  una  forma  geometrica  o  una  scritta.  Si  possono  usare  per  disegnare oppure  per 
selezionare: nel primo caso vanno prima progettate e poi delineate, nel secondo caso la curva va  
convertita in selezione. 
Strumenti utili:

Strumento "tracciati" e relativa finestra di opzioni  (doppio 
clic sullo strumento per aprirla).
Si  disegna e poi  si  decide il  da farsi:  modificarla,  trasfor-
marla in selezione o delinearla.
Le  tangenti:  sono indipendenti,  a  meno  che  non si  tenga 
premuto SHIFT mentre se ne modifica una (trascinare).
CTRL+clic per aggiungere punti. 
CTRL+SHIFT+clic per togliere punti.

Finestra  "tracciati"  (si  apre  dal  menu  delle  Finestre  → 
Agganciabili). Ogni tracciato può essere nascosto, bloccato, 
delineato...

Strumento "Seleziona" e relativa finestra di opzioni.
Per spostare un certo tracciato.

Un volta che un tracciato è stato delineato, si ottengono due oggetti indipendenti: il tracciato di  
prima e il disegno bitmap abbinato. Ad un tracciato si può anche abbinare un testo, come vedremo.
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Testo e manipolazione di scritte
Scrivere e formattare del testo

Si usa lo strumento "Testo"  , si specificano le sue opzioni e si scrive.

Modificare la forma
Anche  per  il  testo  si  possono  usare  i  normali  strumenti  di  distorsione  (ruota,  scala,  inclina,  
prospettiva, rifletti):

E i vari filtri disponibili, ad esempio Filtri → Artistici → Applica tela e Filtri → Luce e ombra → 
Proietta ombra.

Logotipi
Con  File  → Crea  → Logotipi si  possono 
realizzare facilmente delle scritte spettacolari, 
adatte appunto per loghi e titoli.

Testo lungo un tracciato
Disegnare un tracciato → scrivere un testo → nella finestra delle 
opzioni di testo fare clic sul comando Testo lungo il tracciato.
Si  ottiene un nuovo tracciato,  che si  gestisce come qualunque 
altro tracciato.

Da testo a tracciato
Della finestra delle opzioni  del  testo c'è anche il  comando per trasformare in tracciato il  testo  
selezionato. Può servire per ottenere deformazioni ed effetti strani:

Livelli
C'è  un'apposita  finestra  agganciabile,  che  conviene 
tenere sempre visibile.
Per ciascun livello si può decidere l'ordine di sovrappo-
sizione (salvo lo sfondo), l'opacità (o trasparenza), se è 
visibile o meno (icona occhio),  se va bloccato (icona 
catena) per prevenire modifiche accidentali.
SHIFT+clic sull'occhio per mostrare o nascondere tutti 
i livelli.
Alcuni sono creati in modo automatico (es. le scritte e le 
figure geometriche, altri si creano a mano (icona foglio 
bianco, in basso).
Comandi utili: tutti i sottocomandi di  Livello, e alcuni 
sottocomandi  di  Immagine,  in  particolare  → Fonde i  
livelli visibili e → Appiattisci immagine (la differenza si 
nota solo se almeno un livello è nascosto).
Altro comando utile:  File  → Apri in livello: serve per 
assemblare fra loro più immagini.
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Livelli fluttuanti: prima o poi vanno ancorati ad un livello, usando l'apposito pulsante a forma di 
àncora, in basso sulla finestra dei livelli. Esempio: quando si incolla un'immagine esterna.

Un livello può o meno gestire la trasparenza. La differenza si nota quando si cancella una parte di 
disegno (selezionare una zona e premere CANC): il buco che rimane può essere del colore dello  
sfondo (che di solito è bianco) oppure essere trasparente (e quindi si vede il contenuto del livello  
inferiore). Per aggiungere o togliere la gestione della trasparenza: puntare un livello, clic destro → 
Aggiungi canale alfa (o → Rimuovi canale alfa per l'azione contraria).

L'opzione "Blocca" che si vede nella finestra dei livelli imposta come si comporteranno le zone 
trasparenti quando ci si disegna sopra: se bloccata allora non sarà possibile riempirle, resteranno 
vuote, proprio come se non esistessero.

Griglia
Con  Visualizza  → Griglia la si rende visibile, con  Visualizza  → Griglia magnetica la si rende 
"magnetica" (ha senso solo se è visibile): se si disegna vicino ad un incrocio della griglia, si viene  
attirati da quel punto e quindi si disegnano più facilmente forme regolari.
La si personalizza con Immagine → Configura → Griglia o con Modifica → Preferenze.

Guide
Concetto analogo. Per aggiungerle: le si trascina dal righello. Per togliere una guida: si 
fa clic su un righello, il puntatore cambia forma, quindi si  trascina via la guida dal 
disegno. Comandi utili: quelli sotto a Immagine → Guide.

Tagliare lungo le guide
Disporre  le  guide  nelle  posizioni  lungo cui  tagliare,  quindi  usare  Immagine  → Trasforma  → 
Ghigliottina. Saranno prodotte tante immagini quanti sono i riquadri tracciati dalle guide.
Poi si ottimizzano in modo personalizzato ciascuna immagine, e solo quelle che servono.

Misurare
A parte i righelli, si può usare lo strumento  (Misurino) per misurare distanze fra due punti. 
Una volta tracciata una misura si possono spostare o cliccare i punti estremi: in abbinamento a 
CTRL+ SHIFT o ALT si ottengono risultati diversi, in particolare si aggiungono angoli e guide.

Ridimensionare
Una parte
Si seleziona la parte, quindi si usa lo strumento di trasformazione "Scala".
Usare CTRL per mantenere le proporzioni.

Tutto il disegno
Comando Immagine → Scala immagine. Le proporzioni possono essere bloccate o meno, cliccando 
la catena fra le dimensioni.

Superficie
Con il comando Immagine → Dimensione superficie si varia la dimensione dell'area di disegno 
senza ridimensionarne il contenuto. Di solito serve per ampliare la zona, perché per restringerla,  
sono  più  comodi  questi  altri  sotto  comandi  di  Immagine:  → Adatta  la  superficie  ai  livelli / 
Imposta area disegnabile alla selezione / Ritaglia alla selezione / Autoritaglio immagine.

Oppure si usa direttamente lo strumento "Ritaglia": 
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Ritagli

Per ottenere ritagli,  sfumati  o meno,  di  una foto, con o senza una forma attorno ci  sono varie  
tecniche. Si può sfruttare la selezione inversa, da sfumare e tagliare via, oppure si può copiare 
un'immagine e incollarla dentro una selezione, oppure si  possono sfruttare i  livelli  e quindi far 
trasparire l'immagine da sotto la forma bucata, ...

Utile anche il comando Seleziona → Sfumata, appunto per sfumare la selezione corrente che poi va 
tolta o spostata, a seconda di quanto si desidera ottenere.

In figura precedente: un paio di esempi di cosa si può ottenere.

Fotoritocco
I concetti visti prima valgono in generale e per disegni che si creano da zero.
Quelli che seguono si applicano meglio a fotografie già esistenti, da modificare.

Strumento "Clona": per copiare su un'altra zona dei pixel, con effetti di opacità o meno. 
Con CTRL+clic si seleziona la zona da cui copiare.

Strumento "Cerotto": simile all'altro, ma la zona da cui si copia viene considerata in base 
anche  ai  suoi  colori,  quindi  opera  anche  una  trasformazione  di  colori.  Per  riparare 
imperfezioni va selezionata una zona "sana" simile a quella da riparare. Utile ad esempio  
per eliminare rughe e piccoli difetti della pelle. Funziona bene su aree con poco contrasto.

Sfruttando adeguatamente  questi  strumenti,  le  selezioni  e  i  livelli  si  ottengono fotomontaggi  e 
fotoritocchi anche complessi.

Gestire i colori, creare effetti
Ci sono moltissimi istrumenti per fare questo, a seconda del risultato e delle conoscenze. 
Tenendo sempre a mente la teoria dei colori (riguardo ai colori principali e le varie codifiche), si  
può gestire: il bilanciamento dei colori, le tonalità, la saturazione, la luminosità, il contrasto, ... si  
possono convertire tutti o alcuni colori verso altri, in particolare verso toni di grigio...

Quasi tutto si fa con i sotto comandi del menu Colori. Altri effetti si ottengono applicando Filtri. 
Tenere presente che tutti  agiscono solo sulla selezione,  quindi,  selezionando parti  si  ottengono  
risultati interessanti.

Esempio: con Filtri → Render → Linea nova si posso aggiungere dei raggi convergenti al centro.
Notare che il comando  Colori  → Posterizza riduce il numero di colori usati, ma non il peso del 
corrispondente file ottenuto.

Per trasformare la foto da colori a bianco e nero: comando Colori → Desaturazione.

Per trasformarla in toni seppia, stile antico: dopo averla trasformata in bianco e nero, usare Colori  
→ Colora e applicare una "Tonalità" attorno al 35 e una "Saturazione" attorno al 30.

Per antichizzare con bordo sfumato segnalo il filtro: Filtri → Decorativi → Vecchia foto.
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Esempi pratici
Seguono ora alcuni problemi tipici e come rimediare. Va de sé che solo con molta pazienza e molta 
pratica otterrete i risultati migliori, quindi..... provate e riprovate.

Occhi rossi
Fra i tanti filtri c'è l'utile  Filtri  → Miglioramento  → 
Rimozione  occhi  rossi che  apre  un  dialogo  in  cui 
dosare  la  forza  dell'intervento.  In  pratica  vengono 
rimossi gli eccessi di rosso dall'intera selezione, quindi 
può convenire applicare il filtro dopo aver selezionato 
le sole pupille.

Per  selezionare  una  pupilla  conviene  usare  lo 
strumento  di  selezione  ellittica  tenendo  premuto 
CTRL per selezionare dal centro della pupilla, anche 
SHIFT per la forma perfettamente rotonda.

Raddrizzare una foto
Comandi utili:

• strumenti  (Scala, Inclina e Prospettiva)
• comando Livello → Trasforma → Rotazione arbitraria.
• aiutarsi con la griglia e le guide per avere dei riferimenti su come agire.

Ecco un esempio di trasformazione possibile, le eventuali parti mancanti nella foto trasformata si  
ricostruiscono facilmente usando lo strumento Clona:

Cornici
Per creare una cornice (su un livello trasparente), da 
sovrapporre ad un altro livello da incorniciare:

1) creare  una  selezione  adatta  sottraendo un 
rettangolo più interno

2) applicare a quella selezione una  sfumatura 
con un  gradiente a scelta ma con la forma 
sagomata (uno qualunque dei tre tipi).
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Correggere il controluce

prima dopo

L'ideale sarebbe usare il flash mentre si scatta la foto. Se però per qualche motivo il primo piano  
risulta comunque troppo scuro rispetto al fondo, o, anche si vuole scurire lo sfondo, si rimedia con  
GIMP. Vediamo come:

1) Il primo passo consiste nel selezionare la sola zona da schiarire (nell'esempio in figura, il  
capitello):  questo si  fa sfruttando il selettore  fuzzy e i tasti SHIFT o CTRL per sommare o 
sottrarre alla selezione parti rimaste fuori o in eccesso.
2) Nella finestra di opzioni per la selezione, conviene impostare una buona sfumatura, per non 
avere contorni troppo netti, così come conviene dedicare cura e tempo per selezionare tutte le  
parti (cose che non ho fatto io, nella figura "dopo").
3) Visto  che  il  risultato  a  cui  stiamo  per  andare  incontro  è  incerto,  conviene  copiare  la  
selezione su un livello superiore e lavorare lì: se viene male basterà eliminare il livello e rifare 
tutto. 
4) Provare sulla selezione il comando Colori → Luminosità-contrasto.
5) Forse i risultati migliori si ottengono invece con Colori → Livelli: dove, per schiarire tutto 
si trascina verso sinistra il triangolo bianco (di destra) dei "Livelli in ingresso":

Fatto  questo,  volendo  scurire  un  po'  il  cielo  potreste  agire  nel  modo  inverso,  nella  selezione 
inversa, e cioè:

1) tornate sul livello della foto, e in Colori → Livelli spostate invece verso destra il triangolo 
nero (a sinistra) dei "Livelli in ingresso".

Ridurre il rumore
Per ridurre la fastidiosa sgranatura che a volte si ha in certe foto scattate ad alta sensibilità potreste  
provare un paio di comandi:
• Filtri → Sfocature → Selettiva gaussiana: qui decidete il "Raggio di sfocatura" (intensità della 

sfocatura, in pixel) e il "Massimo delta" (la soglia di intervento). Dovreste ottenere immagini in 
cui vengono sfuocate solo aree a basso contrasto (dove si suppone che no ci siano dettagli  
interessanti da perdere)

• Filtri → Miglioramento → Smacchiatura: pensato più per eliminare graffi o piccole macchiette 
che per ridurre il rumore, ma si ottengono discreti risultati.

Il problema è che si rischia di perdere dettagli. Ecco che potreste applicare il filtro solo a certe zone  
della foto, tipicamente lo sfondo, o aree senza dettagli interessanti: basta selezionare quelle zone 
prima di eseguire il comando.
Difficilmente otterrete ottimi risultati, quindi accontentatevi di una buona via di mezzo in cui i  
dettagli non saranno troppo persi, pagando con un po' di gran.
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Primi piani con più profondità di campo

prima dopo

Lo sfondo sfumato fa risaltare meglio un primo piano, perché l'occhio non è distratto da dettagli  
inutili. Come fare:

1) Il passo più laborioso consiste nel selezionare con cura la sola figura: per esempio con le  
"Forbici intelligenti", o con la "maschera veloce", facendo attenzione ai capelli e dettagli fini.

2) Tagliare e incollare in un nuovo livello, come già imparato, in modo da staccare fra loro le 
due parti e poterle quindi trattare diversamente, come avevamo fatto per il capitello troppo 
scuro.

livello 1 livello 2

3) prima di procedere alla sfuocatura, conviene copiare dentro alla sagoma vuota parte del 
contorno,  come se si  ricostruisse il  solo sfondo: per farlo è utile lo strumento "Clona".  In  
questo modo si eviterà l'alone che è invece risultato a me nella foto "dopo".

4) Sfuocate a piacere il primo livello: comando Filtri → Sfocature → Gaussiana.

Fatto!
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Cambiare sfondo
Con la tecnica appena vista (ritagliare una sagoma e separarla dal suo sfondo) potete fare mille  
altre cose,  per esempio cambiare del  tutto lo sfondo, come nei due esempi  che seguono, basta 
copiare su un nuovo livello (inferiore alla sagoma) una sfondo preso da un'altra immagine.

esempio 1 esempio 2

Un cielo più attraente

originale filtro sul cielo sostituzione cielo

Staccare fra loro parti di una foto serve anche per agire ad esempio sul cielo e rendere più attraente  
un cielo scialbo. 

• Nella prima soluzione (seconda figura) ho usato Colori → Colora per colorare di un bel blu e 
Colori → Luminosità-contrasto per enfatizzare le poche nuvole.

• Nella seconda soluzione ho proprio sostituito lo so sfondo.

Per quanto riguarda i cavi, li si potrebbe eliminare anche dalla seconda soluzione: basta usare lo  
strumento "Clona". Ma in questo caso li ho lasciati per dare un po' di movimento ad una foto che  
altrimenti sarebbe troppo piatta, con un cielo così omogeneo.

Ottenere belle foto
Per ottenere belle foto è necessario adottare degli  accorgimenti  già in fase di  scatto della foto 
stessa. Certi difetti che comunque restano si possono correggere, come visto, con un programma 
come GIMP. Ma per imparare quali  sono le cose principali  a cui stare attenti  e quali  sono da  
correggere, sarebbe molto utile seguire un corso di fotografia. Intanto vi segnalo questa pagina:
http://www.fotochepassione.com/errori/errori.htm
dove trovate una lista degli errori fotografici più comuni, da evitare o rimediare.
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Esportare e ottimizzare
Prima di tutto salvare sempre l'immagine nel formato di GIMP (.XCF), poi usare File → Salva una 
copia (da preferire a  → Salva come per continuare a lavorare sull'originale) quindi scegliere il 
formato opportuno nella parte inferiore del dialogo ("Seleziona tipo di file per estensione"). 

Formati principali:

BMP massima qualità e portabilità, ma si paga con un peso molto alto
JPG è il più adatto per le fotografie, si può regolare la qualità, e di conseguenza il peso
GIF è il più adatto per disegni geometrici, con pochi colori (max 64), accetta trasparenze
PNG ibrido fra i due precedenti

Prima di salvare il file, se si sa già che si sceglierà il formato GIF o PNG, conviene usare prima il 
comando Immagine → Modalità → Indicizzata per ridurre il numero di colori.

Animazioni
Si sfruttano i livelli. Ogni livello è un fotogramma, dal più basso al più alto. Quando si salva ( File 
→ Salva come) si deve scegliere il formato GIF poi "come animazione".
Con Filtri → Animazioni → Esecuzione si ha un'anteprima del risultato.
Animazioni automatiche particolari con Filtri → Animazioni (per es. "Onda").
Per dettagli consultare le molte guide on line.
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Aiuto e links utili
NOTA: per "tutoriale" si intende una guida veloce, breve, che affronta solo uno o pochi argomenti.
Oltre al solito tasto F1 (che in qualunque programma chiama la guida in linea di quel programma) 
potete premere  SHIFT+F1 dopo aver puntato il mouse su una opzione o strumento sconosciuto; 
chiamerà l'aiuto relativo proprio a quella funzione.
http://gimp.linux.it/www/

Sito  principale  italiano  su  GIMP  dove  trovare  da  scaricare  il  programma  (gratis)  e 
documentazione varia: ci  sono anche video guide e un manuale di circa 600 pagine (in 
formato PDF).

http://www.istitutomajorana.it/index.php?
option=com_content&task=view&id=413&Itemid=33

Sono le video guide a cui rimanda l'altro link.
http://www.tutorialpc.it/gimp.asp

Breve guida introduttiva on line.
http://docs.gimp.org/it

Si trova un'ottima guida (del Team di sviluppo), ma da leggere on line.
http://grafica.html.it/guide/leggi/15/guida-gimp/

Utile guida in 22 lezioni (di Luca Perrone), da leggere on line.
http://www.manuali.net

Ricco di guide veloci, e-book più corposi, corsi... e link a materiale esterno interessante, 
anche liberamente scaricabile. Nella sezione "CORSI" c'è addirittura un intero corso (30 
lezioni PDF) disponibile gratis.

http://happytux.altervista.org/gimp/home.html
Alcune guide su aspetti specifici, da leggere on line.

http://www.mrwebmaster.it/the-gimp/articoli/
Alcuni articoli tutoriali (on line) molto specifici:
1) Creare un effetto polaroid
2) Creare una scritta con doppio bordo e riflesso
3) Creare uno screenshot di una pagina web con un effetto di riflessione
4) Creare un effetto lente d'ingrandimento
5) Creare un testo con effetto luce sullo sfondo
6) Creare un testo in rilievo con l'effetto ombra

http://gimp-tutorials.net/
Veloci e pratici tutoriali (in inglese, on line) con molti suggerimenti grafici.

http://portableapps.com/apps/graphics_pictures/gimp_portable
Per avere una versione leggerissima e portatile di GIMP (per esempio in una chiave USB)..

http://registry.gimp.org/
Molti plug-in (estensioni) per potenziare ulteriormente GIMP.

http://tml.pp.fi/gimp/pspi.html
Per poter usare anche in GIMP i plug-in di PHOTOSHOP.

http://liquidrescale.wikidot.com/
Interessante plug-in per deformare uno sfondo preservando alcune zone presegnalate.

http://www.fotochepassione.com/errori/errori.htm
Lista di errori comuni da evitare, scattando o correggendo una foto.
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